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Privileged Access Suite for UNIX

UNIX security simplified

Privileged Access Suite for UNIX solves the intrinsic security and administration issues of
UNIX-based systems (including Linux and macOS) while making satisfying compliance
requirements easier. It unifies and consolidates identities, assigns individual accountability,
and enables centralized reporting for user and administrator access to UNIX. The Privileged
Access Suite for UNIX combines an Active Directory bridge and root delegation solutions
under a unified console that grants organizations centralized visibility and streamlined
administration of identities and access rights across their entire UNIX environment.

Active Directory bridge

Achieve unified access control, authentication, authorization, and identity administration
for UNIX, Linux, and macOS systems by extending them into Active Directory (AD) and
taking advantage of AD’s inherent benefits. Patented technology allows non-Windows
resources to become part of the AD trusted realm, and extends AD’s security, compliance,
and Kerberos-based authentication capabilities to UNIX, Linux, and macOS. See
www.oneidentity.com/products/safeguard-authentication-services/ for more information
about the Active Directory Bridge product.

Root delegation

The Privileged Access Suite for UNIX offers two different approaches to delegating the UNIX
root account. The suite either enhances or replaces sudo, depending on your needs.

e By choosing to enhance sudo, you will keep everything you know and love about
sudo while enhancing it with features like a central sudo policy server,
centralized keystroke logs, a sudo event log, and compliance reports for who can
do what with sudo.

See www.oneidentity.com/products/privilege-manager-for-sudo/ for more
information about enhancing sudo.

e By choosing to replace sudo, you will still be able to delegate the UNIX root privilege
based on centralized policy reporting on access rights, but with a more granular
permission and the ability to log keystrokes on all activities from the time a user logs
in, not just the commands that are prefixed with "sudo." In addition, this option
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implements several additional security features like restricted shells, remote host
command execution, and hardened binaries that remove the ability to escape out of
commands and gain undetected elevated access.

For more information about replacing sudo, see
www.oneidentity.com/products/privilege-manager-for-unix/.

Privileged Access Suite for UNIX

Privileged Access Suite for UNIX offers two editions: Standard edition and Advanced
edition. Both editions include the Safeguard Authentication Services patented technology
that allows organizations to extend the security and compliance of Active Directory to
UNIX, Linux, and macOS platforms and enterprise applications. In addition:

e The Standard edition licenses you for Safeguard for Sudo.

 The Advanced edition licenses you for Privilege Manager for Unix.

About this guide

The Safeguard Authentication Services macOS Administration Guide describes the port of
the Safeguard Authentication Services for macOS product to the macOS platform.
Safeguard Authentication Services for macOS brings the enterprise functionality Safeguard
Authentication Services supplies on every other major UNIX platform to macOS.

Safeguard Authentication Services supports both macOS and macOS Server. Safeguard
Authentication Services recommends that you install all the latest Apple system updates
before installing Safeguard Authentication Services.

In this guide you will find step-by-step instructions on installing, configuring, and
uninstalling Safeguard Authentication Services along with a detailed explanation of the
Safeguard Authentication Services components for macOS.

In addition, the Group Policy for macOS section documents each policy supported for this
version of Safeguard Authentication Services for macOS.

This guide is not comprehensive and only describes those Safeguard Authentication
Services features specific to macOS. For the complete documentation on all other
Safeguard Authentication Services features, see the Safeguard Authentication Services
Administration Guide.

NOTE: The term "Unix" is used informally throughout the Safeguard Authentication
Services documentation to denote any operating system that closely resembles the
trademarked system, UNIX.
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Installation

This section includes instructions for installing and configuring the Safeguard
Authentication Services agent on macOS.

Safeguard Authentication Services
macOS agent installation

Download Safeguard Authentication Services from the Support Site, Download Software
page. The Safeguard Authentication Services software is provided in macOS subdirectory.
You can install the Safeguard Authentication Services agent software through the graphical
user interface or from the command line, more common in a mass deployment scenario.

Installing using the graphical system
installer

You can install the Safeguard Authentication Services for macOS agent software through
the graphical system installer.

To install Safeguard Authentication Services using the graphical system installer

1. Navigate to the macOS folder for your operating system. You will see a folder
containing the macos disk image: macos.

2. Select the VAS-<version>.<build number>.dmg file where <version> is the version
and <build number> is the build number of your Safeguard Authentication
Services release.

3. Double-click the VAS-<version>.<build number>.dmg file. The .dmg contents mounts
on your system.

4. Check the following:
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e The .dmg contents are located in /Volumes/VAS-Installer and appear as a
mounted volume in the Finder window.

e Under the mounted disk image, you will find the Safeguard Authentication
Services metapackage (VAS.pkg). This metapackage contains all Safeguard
Authentication Services client components.

Installing with the wizard

You can install the Safeguard Authentication Services for macOS agent software through
the installation wizard.

To install Safeguard Authentication Services

1.

Double-click the VAS. pkg file from Finder. The installation wizard starts to guide you
through the installation process.

On the Welcome dialog, you can click the & to see the Certification Authority.
On the Introduction dialog, click Continue to proceed with the installation.

On the License dialog, click Continue then click Agree to agree to the
license terms.

On the Destination Select dialog, select the disk where you want to install
SAS for macOS software. The space required is shown. After selecting the disk,
click Continue.

On the Installation Type dialog, you can install the standard components and,
optionally, install additional custom components:

e Click Install to install the standard components and accept the default
installation location on the root volume. You must install the packages on the
root volume and you can not relocate them. The standard components include
Safeguard Authentication Services Client and Group Policy.

e Click Customize to select additional components from these options:
e Safeguard Authentication Services Software Development Kit (SDK)

e Dynamic DNS Update, which supports authenticated A-record and PTR-
record updates to the Microsoft DNS servers.

e Certificate Autoenroliment
« Smart Card

7. The system installer prompts you for local administrator credentials when the

software installation begins.
Enter administrator credentials and click OK.

NOTE: If you do not have administrator rights for your system, contact your
system administrator for assistance.
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8. The Summary screen confirms a successful Safeguard Authentication Services for
macOS installation. Click Close to exit the wizard.

Custom installation

A custom installation includes the following options:

» Safeguard Authentication Services Software Development Kit (SDK)

e Dynamic DNS Update, which supports authenticated A-record and PTR-record
updates to the Microsoft DNS servers.

o Certificate Autoenrollment
e Smart Card

To perform a custom install

1. On the Installation Type screen, click the Customize button to select additional
components (besides the Safeguard Authentication Services Client and Group Policy)
of the product you want to install.

Once you have selected the additional components to be installed, click Install.

2. The system installer prompts you for local administrator credentials when the
software begins to install.

Enter administrator credentials and click OK.

3. The Summary screen confirms a successful Safeguard Authentication Services for
macOS installation. Click Close to exit the wizard.

Command line installation

You can either install the Safeguard Authentication Services metapackage, which installs all
of the Safeguard Authentication Services packages, or you can install one or more of the
individual Safeguard Authentication Services packages contained in the Safeguard
Authentication Services metapackage using the system command line installer:
/usr/sbin/installer.

NOTE: If you do not have administrator rights for your system, contact your system
administrator for assistance.

You must launch a Terminal.app instance to complete the following tasks.
» Installing the metapackage from command line

* Mounting and unmounting the .dmg from the command line
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Installing the metapackage from command line

One Identity recommends using the install script that you downloaded with the rest of
Safeguard Authentication Services instead of using the following steps. However, when you
install vas.pkg, it installs the Safeguard Authentication Services client, the group policy
client, and the dnsupdate as well by default. Using the install.sh script with the download
allows you to choose individual packages to install.

To install all of the Safeguard Authentication Services packages found in the
Safeguard Authentication Services metapackage

1. Open a Terminal.app window and run the following commands
2. Change directories to the location where you mounted the Safeguard Authentication
Services.dmg:
$ cd /Volumes/VAS-Installer
3. Execute the command line installer with the following arguments:
$ sudo /usr/sbin/installer -pkg VAS.mpkg -target /
This installs all of the Safeguard Authentication Services packages contained in the
Safeguard Authentication Services metapackage.
4. Run the following command to install individual Safeguard Authentication Services

components.

$ cd /Volumes/VAS-Installer/VAS.mpkg/Contents
$ sudo /usr/sbin/installer -pkg Packages/vasclnt.pkg \ -target /

NOTE: You must install all Safeguard Authentication Services components into the root
file system, so the parameter to the target command line option must be /. Also, you
must have local administrator rights to run commands using the sudo utility.

Mounting and unmounting the .dmg from the
command line

It is recommended that you use the install.sh script versus this process.

To mount and unmount the Safeguard Authentication Services .dmg from the
command line

1. Mount the Safeguard Authentication Services agent .dmg from the command line and
run the following command:

hdiutil attach /<path_to_dmg>/VAS-<version>.<build number>.dmg
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The .dmg contents mounts on your system, under
/Volumes/VAS-Installer

2. To unmount the Safeguard Authentication Services agent .dmg from the command
line, run the following command:

hdiutil detach /Volumes/VAS-Installer

Agent upgrade

To upgrade Safeguard Authentication Services, simply follow the normal installation steps
for both the GUI process and the command line process. The Safeguard Authentication
Services installation scripts detect when an upgrade is being performed and automatically
perform the proper steps to upgrade versions.

macOS agent removal

Safeguard Authentication Services provides an uninstaller that removes the Safeguard
Authentication Services packages from the system. The uninstaller is found in
/Applications/Uninstall SAS n.n.n (where n.n.nindicates the product version number).

To uninstall Safeguard Authentication Services

1. Inthe Finder window, navigate to /Applications.
The uninstaller requires administrator credentials.

2. Double click the Uninstall Safeguard Authentication Services n.n.n application
(where n.n.n indicates the product version number).

The uninstaller displays the packages that you can remove.

NOTE: When removing Safeguard Authentication Services from your system, files owned
by accounts supplied by the Safeguard Authentication Services components appear as
not having a valid owner since those accounts are no longer available to the system.
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Safeguard Authentication Services
macOS components

The following Safeguard Authentication Services UNIX components are included in the
Safeguard Authentication Services macOS port:

e The vastool command line utility

e The vgptool command line utility

e The uptool command line utility

e The pam_vas PAM module

e The One Identity Ownership Alignment Tool (OAT)

You can use these components inside a Terminal session the same way you use them on
any other UNIX platform. Man pages for each of these utilities are automatically installed
and configured and you can view them with a standard man page viewer. The Safeguard
Authentication Services join process automatically configures UNIX applications to use the
pam_vas module where appropriate.

The components described in this section are specific to the macOS platform.

Startup items

A launchd config plist file is installed for each Safeguard Authentication Services daemon
under /Library/LaunchDaemons.

These .plist files are used to put the Safeguard Authentication Services daemons under
the control of 1launchd. You can use the launchctl utility to add or remove any one of these
daemons from launchd control. For example, to remove the Safeguard Authentication
Services caching daemon (vasd) from launchd control, run the following command in a
Terminal session:

$ sudo /bin/launchctl unload /Library/LaunchDaemons/com.quest.vasd.plist

You can also stop a daemon using launchctl, but the Safeguard Authentication Services
daemon configuration is such that launchd immediately restarts the stopped daemon
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unless you specify the unload command. If it is necessary to restart any one of the
Safeguard Authentication Services daemons, run a command similar to the following:

$ sudo /bin/launchctl stop com.quest.vasd

The Safeguard Authentication Services join process automatically runs the necessary load
commands at join time to put the Safeguard Authentication Services daemons under
launchd control. Typically, users do not need to directly interact with the Safeguard
Authentication Services startup items.

Directory Service plugin

Safeguard Authentication Services provides a plugin for the system DirectoryService
daemon.

The Safeguard Authentication Services Directory Service plugin uses the rest of the
Safeguard Authentication Services components to provide Active Directory group and user
information to the rest of the system, and is installed at
/Library/DirectoryServices/Plugins/VAS.dsplug.

The Safeguard Authentication Services Directory Service plugin also uses Kerberos
authentication for Active Directory users. The plugin operates both when the system is
connected to a network where Active Directory is available, and for disconnected scenarios
where the macOS system cannot contact Active Directory. The Safeguard Authentication
Services Directory Service plugin provides secure authentication and performance identity
lookups even in this disconnected mode.

Disconnected mode is available without having to create local Mobile Accounts on each
macOS system. The Safeguard Authentication Services caching architecture also minimizes
the impact that each macOS system has on the Active Directory environment.

Directory Utility

You use the Directory Utility application to configure the Directory Service Plugins that
provide identity information for authenticating to the machine. When installed, Safeguard
Authentication Services is one of the plugins.

@NE IDENTITY Safeguard Authentication Services 6.1 macOS Administration Guide

by Quest Safeguard Authentication Services macOS components



Safeguard Authentication Services
client configuration

Before you can log in with Active Directory users and manage agent settings for users and
computers, you must first join your macOS machine to an Active Directory domain.

Joining the Active Directory domain

Safeguard Authentication Services provides both a graphical option and a command line
option for joining the domain.

NOTE: You cannot manage agent settings by means of Safeguard Authentication
Services Group Policy if you have joined with the Apple-provided Active Directory plug-in.
If you are currently bound to the domain using Apple components, unbind before
proceeding.

Using QAS Join application

You can use the QAS Join application to join the domain.

To join the domain using the QAS Join application

1. Open the QAS Join application located at /Applications/QAS Join.

2. Onthe Safeguard Authentication Services dialog, enter the name of the Active
Directory Domain you want to join and click Join Domain.

3. On the Join Domain dialog, enter the Active Directory credentials to be used to join
the domain.

From this dialog you can also specify a number of optional join arguments before
continuing with the join operation. For example, you can specify a specific Active
Directory container in which you want to create the new computer object (by default,
it is created in the Computers container). For a detailed explanation of each join
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option, see the vastool/ man page located in the docs directory of the installation

media.
Join Domain
Active Directory Username: | Administrator
Password: ®eeesssssssssses
Options  ~

User Home Config  Advanced

Creating Computer Identity

Computer Name:

Creation Location (DN): | ou=osx,dc=red,dcvas ‘

Overwrite Existing Computer Identity

Specify Domain Controller

Use Explicit Domain Controller (Disables DNS)

Domain Controller:

Generate Unix Identity Attributes
Join in Workstation Mode

4. Click OK to run the join operation.

The join operation may take several seconds, to several minutes depending upon
your domain configuration. Domain Join progress is continuously updated as
progress proceeds.

5. If any errors occur during join, an error dialog opens with a detailed error message as
well as the option to view and save the join process log. As an example, the error
message below is seen if you specified an incorrect password for the account you are
using to join to the domain.
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I | QAS Directory Configuration Plugin

e ERROR: Could not authenticate as Administrator.
K, f_} Invalid username or password.
- WVAS ERR_KRBS: at ticket.c:77 in

_ticket_generate_good_error
Failed to obtain credentials. Client:
Administrator@RED.VAS, Service: krbtgt/
RED.VAS@RED.WAS, Server: win-5drlinnal9g.red.vas
Caused by
KRESKDC_ERR_PREAUTH_FAILED (-1765328360):
Preauthentication failed
ERROR: Could not join to the domain
ERROR: vastool failed, err = 2.

Unjoining an Active Directory domain

To leave the Active Directory domain, repeat the join steps, except click Leave Domain
instead. You do not have to supply Active Directory credentials when unjoining if you do not
delete the Active Directory computer object. This option is available in the Leave Domain
dialog options.

Command line join

Use the vastool utility to perform a command line join.

At the command line, enter vastool join to join the macOS system to an Active
Directory domain.

Using Terminal.app to join and unjoin

You can access the same functionality that is available through the QAS Join application
using the Safeguard Authentication Services command line utilities.

There are two ways to join your macOS system to an Active Directory domain:

e Run the vasjoin.sh script.
$ sudo /opt/quest/libexec/vas/scripts/vasjoin.sh

This script prompts you for information needed to perform the join operation without
requiring you to know the syntax of the vastool join command.
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e Run the vastool join command.
$ sudo /opt/quest/bin/vastool -u Administrator join -f example.com

To leave an Active Directory domain from a Terminal session, use the vastool
unjoin command.

NOTE: For more information about the vastool join or vastool unjoin commands, see
the vastool man page located in the docs directory of the installation media.

System changes made by the join process

When joining an Active Directory domain, Safeguard Authentication Services automatically
modifies the following system configurations:

» Safeguard Authentication Services is added to the DirectoryService search path.

e The Safeguard Authentication Services startup items are configured to start up
automatically

e The system Kerberos configuration file is configured to use the Active Directory
servers that Safeguard Authentication Services detects.

e Group Policies configured for the macOS system are applied by the Group Policy
components if they are installed.

Once you have successfully completed the Safeguard Authentication Services join process,
you are immediately able to log in to the macOS system through the macOS Login Window.

When leaving a domain, the Safeguard Authentication Services unjoin process reverts the
above changes that were made by the Safeguard Authentication Services join process.
Also, uninstalling Safeguard Authentication Services automatically reverts the above
changes as well.

TIP: You can rejoin on top of existing computer accounts created with the macOS Active
Directory plugin by default using the Safeguard Authentication Services Active Directory
plugin. However, One Identity recommends disabling the macOS Active Directory plugin
so that the domain will not appear in the Directory Servers window as not responding.

Verifying the installation and configuration

It is important to verify that your system is configured correctly to use the Active Directory
account information provided by Safeguard Authentication Services.
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To verify the Safeguard Authentication Services installation and configuration

1. Run the following shell commands.

e To show a list of the available UNIX-enabled Active Directory users, enter:
dscl /VAS list /Users

e To show a list of the available UNIX-enabled Active Directory groups, enter:
dscl /VAS list /Groups

e To ensure that the system can read user information for Safeguard
Authentication Services users, enter:

dscl /Search read /Users/<Username>

where <Username> is the username of a Safeguard Authentication
Services user.

e To perform an authentication for a Safeguard Authentication Services
user, enter:

dscl /Search auth <Username>

where <Username> is the username of a Safeguard Authentication
Services user.

If any of the previous commands do not work, capture debug information from the
Safeguard Authentication Services Directory Service plugin.

2. Add the following items to the vas. conf [vas_macos] section:

[vas_macos]
dslog-mode = /Library/Logs/vasds.log
dslog-components = all

3. After adding those items, run the following shell command in a Terminal session to
trigger the Safeguard Authentication Services Directory Services Plugin to reload its
logger configuration:

$ sudo /opt/quest/libexec/vas/macos/vasdsreload

4. Run the previous verification commands that failed and send the contents of
/Library/Logs/vasds.log to One Identity Support who will assist in resolving
the problems.
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Logging in with Active Directory
accounts

Safeguard Authentication Services for macOS allows you to authenticate to your macOS
system, but before you can use any given account for authentication, you can prepare it for
macOS authentication from a Windows Administrative Console through a process called
UNIX-enabling. However, if you do not have access or permissions to modify user account
information in Active Directory, you can join and specify that you want the Safeguard
Authentication Services client to locally generate UNIX identity information.

To locally generate UNIX identity information, select the Generate UNIX Identity
Attributes option when you join (or, if you are joining using the command line utility,
specify the --autogen-posix-attrs flag). This allows you to use all the features of the
Safeguard Authentication Services client, without requiring any modification to user
information in Active Directory. If you plan to manage identity data in Active Directory
globally, see UNIX-enable a user.

UNIX-enable a user

You UNIX-enable a user by entering the UNIX attributes on the UNIX Account tab in
Active Directory Users and Computers (ADUC) MMC Snap-in.

To UNIX-enable a user

Log in to a Windows Administrative workstation.

Start ADUC.

Locate the user object that you would like to UNIX-enable.
Right-click on the user and select Properties.

Select the UNIX Account tab.

Select the UNIX-enabled check box.

Default values are generated for the user.

ok wnN e

7. Adjust values as necessary and click OK.

Troubleshooting connections to
Windows SMB shares

There are some known issues connecting to Windows shares using Finder. If you log in as a
domain user, Safeguard Authentication Services obtains Kerberos credentials for your login
session. Finder should use these credentials to automatically authenticate when connecting

@NE IDENTITY Safeguard Authentication Services 6.1 macOS Administration Guide 15

Quest Safeguard Authentication Services client configuration



to Windows shares. Instead, Finder prompts you for your password. The two possible
causes for these issues are explained in the following topics:

e Connecting to SMB shares on domain controllers

e The DNS domain name differs from the Kerberos realm

Connecting to SMB shares on domain
controllers

Problem:

When connecting to SMB shares on a domain controller, settings on the default domain
controller policy can force a macOS client to Digitally Sign all traffic. Since macOS clients do
not support digitally signing SMB traffic, this can lead to a failure when attempting to
mount an SMB share.

This issue is related to two settings in the Default Domain Controllers Policy.

Resolution:

Disable the Default Domain Controller policy settings to allow macOS machines to connect
to SMB shares.

To disable policy settings

1. Open Active Directory Users and Computers, select the domain, right-click, and
select Properties.

2. Click the Group Policy tab.

NOTE: If you use Windows Server 2008, there is an additional menu item,
Policies, added between Computer Configuration and Windows Settings in
the following sequence.

a. If the default Domain Controllers Policy is linked to this domain, navigate to
Edit > Computer Configuration > Windows Settings > Security
Settings > Local Policies > Security Options, double-click and disable the
following two policies:

» Microsoft network server: Digitally sign communications (always)
e Microsoft network server: Digitally sign communications (if client agrees)

b. If the Default Domain Policy is linked to this domain, navigate to Edit >
Computer Configuration > Windows Settings > Security Settings >
Local Policies > Security Options, double-click and disable the following
two policies:

e Microsoft network server: Digitally sign communications (always)

e Microsoft network server: Digitally sign communications (if client agrees)
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If these group policies are not currently defined, you can leave them
unconfigured. If either policy is enabled and linked to the domain, however, the
macOS computer is not be able to use SMB connections to mount the Windows
file shares.

3. If you change these policies on the domain controller, run the gpupdate command to
refresh the group policies before logging on to macOS computers.

The DNS domain name differs from the
Kerberos realm

Problem

A network trace reveals if a Kerberos TGS request for the CIFS service ticket was sent to a
domain controller. If a Mac machine never attempts to get a CIFS service ticket for SSO, it
is usually a problem where the machine is not able to connect the host name you are
contacting with a Kerberos realm. When this happens Finder, or any other mounting
application, assumes that the host is not a part of any Kerberos domain for which you have
credentials and prompts you for a user name and password.

This can easily happen if your DNS domain name is not the same as your Kerberos realm
(often referred to as a disjoint DNS name space). It might also happen if you were trying to
connect to the server using a short-name or some other alias.

Workaround

Add a domain to realm mapping for your DNS domain, short-name, or alias under the
[domain_realm] section of the /Library/Preferences/edu.mit.kerberos file.

Safeguard Authentication Services automatically adds a mapping similar to the following
at join time:

[domain_realm]
.example.com = EXAMPLE.COM

This maps any DNS names ending in .example.com to the KRB5 realm EXAMPLE.COM. You
must always specify the destination domain realm in upper case. When attempting to
connect to the share, you must specify the source exactly as the DNS name is specified.

If you are connecting to a share using an alias that does not have a domain suffix, you can
explicitly map that name to a KRB5 realm using a domain realm:

[domain_realm]
shortname = EXAMPLE.COM
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Automatically mount network home
folders

When you UNIX-enable an Active Directory user with Safeguard Authentication Services,
the default configuration for that user is that he or she will use a local home directory. The
home directory path is populated with a UNIX path (/home/<username>).

On macOS systems, /home is replaced with /Users, aligning with the macOS standard
location for local home directories. Safeguard Authentication Services supports the
automatic mounting of network shares (SMB or AFP) using Active Directory credentials, but
you must specify a server path. You can store this server path in the directory on each user
as a UNC path, or as a per machine setting.

You can configure your home folder strategy globally for the entire domain using Group
Policy extensions for UNIX, or you can configure it on a per machine basis at the time you
join your macOS machine to the domain.

Configuring automatic home folder
mounting at join time

This section describes how to configure automatic home folder mounting at join time.

To configure automatic home folder mounting at join time

1. When you are prompted for your administrative user name and password, click the
disclosure triangle.

=

The Join Domain dialog appears.

Active Directory Usérname:

Password:

( Cancel ) Ok )
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2. To show the home folder mounting options, click User Home Config.

Active Directory Username:

Password:

...:""'-=--"""5..
——— Join Options( User Home Config )Advanced
(0 Use Local Home Directories
® Use AD UNC path for network home

Attribute: [ Home Folder M [ SMB M
(O Use the following path for network home
Server Name: _SMB ¢
Share Name:
User Path Expression
' Sam Account Name & | ( Insert Attribute )

( Cancel ) oK)

Mounting the Windows home folder or
profile path

You can configure Safeguard Authentication Services to mount a share that is specified as a
UNC format path and stored on a user. The two most commonly used paths are found on

the users Profile tab in ADUC.
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Genersl | sddess | Accouw  Profie | Telephones | Ongarization |

— Lser profile
Profle path: Ih‘kﬁlvﬁ.ﬂmﬁe.m'hﬂwmam‘ummarm
Logon scipt: |
~ Home folder
© Localpathc |
 Connect: [z ¥| Too [\\serves2 example combsharena

Use Safeguard Authentication Services to mount either the Home Folder or Profile Path on a
macOS agent at log in by selecting Use AD UNC path for network home from the User
Home Config properties.

To mount the Windows Home Folder or Profile Path

From the Join Domain dialog, click the disclosure triangle to expand the dialog.
Select the User Home Config tab to display the home folder mounting options.
Select the Use AD UNC path for network home option.

A W N -

Select the appropriate UNC format path from the Attribute drop-downs.

se path for networ ame
(® Use AD UNC path f k h
Attribute: | Home Folder ke [ sme ke
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Mounting an alternate share at login

If you cannot use the shares specified in Profile Path or Home Folder for some reason (for
example, if your Windows home shares are DFS shares), you can specify an alternate share
at join time by specifying a network home path expression.
To specify a network home path expression

1. From the Join Domain dialog, click the disclosure triangle to expand the dialog.

2. Select the User Home Config tab to display the home folder mounting options.

3. Select Use the following path for network home and enter the Server Name
and Share Name to be used.

®) Use the following path for network home

Server Name: server.example.com | AFP

Share Name: sharename

User Path Expression

%c
' Common Name (cn) k8 ( Insert Attribute )

Selecting this option configures the network home for all users on the machine.
Because of this you must specify how the path name will be resolved for each user.

4. Under User Path Expression, use the drop-down and Insert Attribute button to
specify the appropriate user attributes in the path portion of the server URL.

For example, if you selected Common Name (cn) and clicked Insert Attribute,
the expansion macro for Common Name (%c) is inserted into your path expression.
The path expression may have text and expansion macros, or it may just be a single
expansion macro with no other text.

Configure automatic home folder mounting
using Group Policy

During deployment, installation and join usually happen in a scripted fashion from the
command line. It is still possible to configure home folder mounting without using the
graphical join interface, either through modification of the vas. conf file or by setting the
appropriate options in group polices that apply to your macOS machines.

The two options that have bearing upon home directory mount behavior are nethome and
nethome-mount-protocol. These options are set in the vas. conf policy.
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¥AS Configuration Properties .ﬂﬁl

was. oonf Seftings |

I Saarch |

E [vasd] - YAS Cache Settings -
@ [libvas] - General YAS Settings
Bf[vas_macos] - Mac0s X Settings
admin-users
aiithventication-hink
dslog liberas
dslag-rade
methome Foemeirectory
| cifs
& [vasypd] - YAS NIG Server Settings
B [nss_was] - Name Service Settings
|@ [vas_auth] - Common Auth Module Settings
B [pam_vas] - Pluggable Authentication Module Settings —
i@ [aix_was] Loadable Authentication Module Settings [ALX)
@ [libdefaults] - Kerberos Settings
}E [pkinit] - Smartcard Settings

anl g A

[vas_macos] - HMacOSs X Settings
Options specific Far VAS on Mac 0S5,

The nethome is either the name of the user attribute where the UNC path is stored
("homeDirectory" or "profilePath"), or it is the server URL expression for all users (that is,
cifs://servername/sharename/%c).

If the nethome is specified as an attribute name, you can specify whether the path is
mounted by means of AFP or CIFS using the nethome-mount-protocol setting.

Setting either of these options has no effect on any Safeguard Authentication Services
platform other than macQOS, so you can safely set it on a domain-wide UNIX settings policy.
Creation or modification of group policies is accomplished using the Microsoft GPOE on any
Windows administrative workstation.

Group permissions on auto-mounted home
directories
For Safeguard Authentication Services to resolve to a Windows SID to a UNIX UID or GID,

the user or group to whom that SID belongs must have had a UID or GID manually
assigned to them. Or, in other words, you must UNIX-enable the user or group on the
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UNIX Account tab in Active Directory Users and Computers. If a group or user has not
been UNIX-enabled, the macOS machine will still assign a UID or GID to the user or group,
but the Safeguard Authentication Services agent software will not be able to resolve the a
UID or GID.

To log in to a macOS machine, all users must be UNIX-enabled so this normally only causes
problems when dealing with group permissions on SMB-mounted home directories. It is not
uncommon for the group owner of a network home location to be a group WITHOUT a UNIX
GID assigned. When a user's ability to access this directory relies on correct group
membership, problems can arise. It is, therefore, best practice to UNIX-enable all groups
that are used for SMB File level permissions on network mounted home directories.

Mounting AFP shares

To mount AFP shares, you must have an AFP file server that knows about all your Active
Directory users and credentials. You can easily accomplish this using third-party software
that shares files from a Windows machine joined to your domain.
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Special macOS features

This section details special macOS features:

» Local administrator rights for users
e Active Directory user password hint

» Configuring Apple FileVault disk encryption

Local administrator rights for users

Safeguard Authentication Services allows you to give local administrator rights to
Safeguard Authentication Services users on individual macOS systems. This gives a user
the ability to administer his own system while still using Active Directory for authentication.
It also allows macOS system administrators "admin" access on macOS systems without a
shared local account.

Granting accounts administrator rights

This section describes how to grant administrator rights for Safeguard Authentication
Services accounts.

To grant Safeguard Authentication Services accounts administrator rights

1. Modify the /etc/opt/quest/vas/vas.conf file and add the following section to the
Safeguard Authentication Services configuration using a text editor:

[vas_macos]
admin-users = pats@example.com

For example, with the pico text editor, enter:
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$ sudo pico /etc/opt/quest/vas/vas.conf

NOTE: If there is already a [vas_macos] section in the vas. conf file, just add or
modify the admin-users key following the existing section. You can also manage
this option through Group Policy.

For the value of the admin-users key, use a comma-separated list of Active Directory
User Principal Names (UPN) for Safeguard Authentication Services users with
administrator rights. The Domain Users option also supports groups of users.

2. Specify the group in the Domain\groupname format.

Either step ensures that Safeguard Authentication Services processes the new
configuration.

3. Verify that the configured users have administrator rights by checking their
group memberships using the following command line (the example is for a user
called pspencer):

$ groups pspencer

If pspencer was correctly configured to have local administrator rights, you see the
local admin, appserveradm, and appserverusr groups listed in the output. The
pspencer user is then able to use his user credentials for authorizing administrative
tasks started from the System Preferences application.

Active Directory user password hint

The password hint is displayed for all Active Directory users when you have macOS
configured to provide password hints. The password hint is used to notify a user of a
website where they can reset their password, or to remind a user that the account they are
using requires a domain password. The default value for the authentication-hint is
Windows Domain Password.

Before macOS will display authentication hints, you must enable the Show password
hints option through the log in options.

After enabling password hints, after several incorrect login attempts, the password
hint displays.

You can manage this hint centrally on the domain controller through Group Policy.

NOTE: For security reasons, if mapped users change their password hint, it is
intentionally reset to the generic Windows domain password hint the next time
they log in.
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Configuring Apple FileVault disk
encryption

Safeguard Authentication Services is compatible with Apple’s FileVault disk encryption,
introduced in macQOS 10.7. To use FileVault with an Active Directory user, you must first
create a mobile account for that user on the macOS client. A macOS mobile account has a
local home directory that can automatically sync with the user’s network home directory.

8a0o Users & Groups
[« > ] [ ShowAi | Q )

Cusrent Uses Passwnrd Login ltems |

macuser2
MNetwork, Managed
| Change Password...

¥ Other Users
Guest User
Sharing only
. Alpha Bet Full name: macuser?
Standard
luser Apple I1D: Set...
Standard
n macuser
Admin, Managed, Mob
macuserl Mobile account: | Create...
Managed, Mobile
plainuser Address Book Card: | Open...
‘ Standard -
R R Allow user to reset password using Apple ID
Q Login Options o .
9 P || Allow user to administer this computer
+ - |
n
Click the lock to prevent further changes. (7)

To encrypt your disk

1. As an Active Directory user, open System Preferences and navigate to
Users & Groups.

2. Click the Lock icon and enter administrator credentials to enable preference
changes.

3. Click the Create button next to Mobile account.
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‘D00 Users & Groups

< | > ] [ _ShowAll : . Pr— —e
P—— Home folder in: | (1 Lion (Startup disk) 3
S |
Metwork, M nc: tomatically - L
- d...
Other Users gll login
Cuest Use at | t
1 Sharing onl g egou
@ Aoha bet (*) Home folder
Standard () Only selected folders:
luser Folder &
Standard Svﬂ; :
macuser IS Desktop
Adrmin, Man v/ [l3l Documents
macuserl v i) Downloads
Managed, N v i Library
plainuser v [ Movies
Standard v CElMusic
B T EREEAY .‘f ;nl__,FiCtUrE.‘t
{2} Login Opt v [l Public
| Show status in menu bar | Cancel | | Create |

@

If Click the |

4. Select your preferred syncing and home folder location preferences in the pop-up
menu and click Create.

A popup message displays explaining that you must log out and log back in to create
the local home folder.

Click Create and enter your password at the prompt.

6. Log back in and configure FileVault encryption.
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‘@00 Security & Privacy
| «|» || Showan |

i General Firewall = Privacy |

N FileVault secures the data on your disk by Turn On FileVault...
° encrypting its contents automatically.
WARMNING: You will need your login password or a recovery key to access your data.

A recovery Key is automatically generated as part of this setup. If you forget both
your password and recovery key, the data will be lost.

FileVault is turned off for the disk “Lion".

[Jﬂ Click the lock to prevent further changes. Advanced... @

7. From System Preferences, navigate to Security & Privacy and open the
FileVault tab.
8. Click Turn on FileVault to begin the encryption process.
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000 Security & Privacy

Show All
macuser <
Admin
Entering this user's account password allows them to decrypt o ]
‘ all files on the startup disk.
Password: l.oo.ao.l I
| Cancel | [  OK |
' macuserl Enable User... |
l macuser2 Q
| Cancel | | Continue |
—_—
Iii Click the lock to prevent further changes. | Advanced... ] \"_?)

9. Select users (local users and mobile accounts) to enable them to unlock the
encrypted disk at system startup.

NOTE: Once you enable FileVault unlock for a user account, if you subsequently
delete the account from Active Directory, you must also delete the local user
account to disable FileVault unlock for that user.

10. Enter a password for each user you enable.
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O00 Security & Privacy
[ <] > ][ showal ] Q

| Y K Apple can store the recovery key for you.

4/ If you need the key and cannot find your copy, you can contact Apple to retrieve it
| | To protect your privacy, Apple encrypts the key using the answers to three guestions
’ you provide®.

@ Store the recovery key with Apple
() Do not store the recovery key with Apple

Answer these security guestions.

Choose answers you are sure to remember. No one, not even Apple, can obtain
your recovery key without the answers to these questions.

qk

| Choose a question...

Ak

| Choose a gquestion...

Ak

| Choose a gquestion...

these answers, then Apple will be unable to access the key. Answer attempts may be )
restricted. Apple is not responsible for failing to provide the recovery key. Fees may -
apply, subject to support eligibility.

d‘ﬂ *Apple can only decrypt the recovery key using exact answers. If you cannot provide

?/ | Cancel | | Back | Continue

11. Take note of the recovery key on the following screen; store it somewhere yourself,
and store it with Apple Support.
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8oo Security & Privacy
li,bl[ShDWNlj (Q )

AN FileVault secures the data on your disk by Turn Off FileVault...
& OT encrypting its contents automatically.

FileVault is turned on for the disk “Lion".

A recovery key has been set.

Emcrypting... [
4 hours remain
| Some users are not able to unlock the disk. | Enable Users...
. jp . o~
™ CQlick the lock to prevent further changes. [ Advanced... | | ? )

12. Restart your system to begin encrypting the drive.

The encryption can take several hours, depending on the size of your disk, during
which time you can continue using your computer. You can monitor the encryption
process by returning to the FileVault tab in Security & Privacy preferences.

After you enable FileVault, your macOS will initially boot to an unencrypted disk
partition and ask for your password to unlock the encrypted partition. Because this
separate partition does not have access to Safeguard Authentication Services and
Active Directory, you must use your most recent locally cached password. Before the
local cache is updated, if you need to unlock the encrypted disk after a password
change, either use your old password or click the Recover Key to unlock the drive.
Once the drive is unlocked, although it says you must reset your password, you can
ignore the prompt and log in with your recently changed account password.
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Limitations on macOS

There is some Safeguard Authentication Services functionality that is limited by the
macOS system.

Limitations lists

e When using the command line su utility to become a Safeguard Authentication
Services user, the Safeguard Authentication Services PAM module will not create a
ticket cache for the new session because Safeguard Authentication Services uses the
CCacheServer process for Kerberos ticket cache management. Creating this ticket
cache would inadvertently destroy any existing Kerberos tickets.

» If Safeguard Authentication Services users who have custom home directory paths
log into the system through the system login window and the parent directories for
their home directory do not exist, the system home directory creation code
incorrectly sets the ownership mode of all the home directory parent directories. This
causes subsequent Safeguard Authentication Services user logins to fail if they share
the same home directory path. Their home directory will be created but it will be
inaccessible to the user.

Administrators should ensure that if they are using custom home directory paths, the
parent directories are pre-created with a valid ownership and mode that allows all
Safeguard Authentication Services users to access those paths.

e The automatic ticket feature of Safeguard Authentication Services does not currently
work with non-file-based ccaches. Because macOS uses API based ccaches, the
ticket renewal utility will not work.

NOTE: You can manually renew tickets with any utility that supports renewing
tickets, such as Apple's Ticket Viewer.

e When using the Safeguard Authentication Services mapped user feature, if a local
user is mapped to a Safeguard Authentication Services user and, at some point the
user is unmapped (returned to a local account) you must reset the user’s password.

@NE IDENTITY Safeguard Authentication Services 6.1 macOS Administration Guide

by Quest Limitations on macOS



Group Policy for macOS

With Safeguard Authentication Services you can manage your macOS clients using Group
Policy. Safeguard Authentication Services includes Group Policy extensions to manage
preferences just as you would with Workgroup Manager. In addition, Safeguard
Authentication Services supports custom policies based on Preference Manifests.

Safeguard Authentication Services Group Policy includes support for macOS. Using
Safeguard Authentication Services you can manage your macOS through Group Policy. This
eliminates the need to set up additional macOS Servers for macOS client management.
macOS policy settings are applied using Profile-based policies.

Profile-based policy takes advantage of the Configuration Profile infrastructure provided by
Apple. Policy settings are defined in Group Policy and downloaded to macOS clients where
the settings are assigned to Configuration Profiles, which apply the settings to various
configuration files on the macOS.

Profile-based policy

Profile policy settings are divided into two categories: Workgroup Manager Settings and
Preference Manifest Settings.

The Workgroup Manager settings are designed to look and feel like the Workgroup Manager
application. If you are familiar with Workgroup Manager from macQOS server, it should be
easy to transition to Group Policy. Settings for Applications, Classic, Dock, Energy Saver,
Finder, Login, Media Access, Network, Parental Controls, Printing, Software Update,
System Preferences, Time Machine and Universal Access are included. Safeguard
Authentication Services supports the Never, Always and Once policy application options.
You can apply settings to users or computers. With standard Group Policy security filtering,
you can restrict settings to specific groups of users or computers.

Safeguard Authentication Services also includes support for Preference Manifest files.
Preference Manifest files describe application settings you can manage centrally. Many
standard macOS Preference Manifest files are included by default such as iChat, Mail,
Sidebar, Time Zone and iTunes. You can import additional Preference Manifest files at any
time, increasing the number of applications and features that you can manage.
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On the macOS agent, Group Policy integrates with the Configuration Profile subsystem
according to macOS best practices. This ensures that policy settings are applied correctly
and appropriately to each new release of macOS.

macOS management modes

The following management modes exist for macOS policy settings:

Table 1: macOS: Management modes

Mode Description

Never This mode means that the settings do not apply. This is equivalent to disabling
the policy. This is the default mode.

Once In this mode, policy settings are applied one time. Users can remove the
Configuration Profile. This mode functions as a default value.

Always  In this mode, policy settings will always apply. Users cannot remove the
Configuration Profile.

Installing profiles on macOS 11.0 and later

Safeguard Authentication Services for macOS relies on the /usr/bin/profiles command
to install configuration profiles. Starting in macOS version 11.0, this command can no
longer be used to add profiles. To create a profile on macOS 11.0, use the System
Preferences pane.

When installing profiles with system preferences, the agent installs both Device (also
known as Machine profiles in the Group Policy plugin) and user profiles.

To install a profile on macOS 11.0 (and later):

1. Login to a macQOS system.
A prompt appears, asking you to install a new profile.
Open System Preferences and click Profiles.
In the Profiles pane that appears, click Install.

Device profiles only. In the dialog box that appears, type the user name and
password of the device administrator account.

NOTE: You must specify administrative credentials when creating Device profiles. Any
standard user can create a User profile without providing administrative credentials. An
Always profile must have a password unique to that profile in order to remove it. A Once
profile can be removed at any time.

The new profile is successfully installed and it appears available for selection.
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Workgroup Manager Settings

Safeguard Authentication Services provides Group Policy extensions that mirror the
functionality available in Apple Workgroup Manager console. The Workgroup Manager
Settings are located in the Mac OS X Settings folder (or in the Policies folder, if you are
using the new Group Policy Management Editor.)

To open the properties of the Workgroup Manager settings

1. Start the Group Policy Management Editor.

2. Navigate to Computer Configuration > Mac OS X Settings or User
Configuration > Mac OS X Settings.

3. Double-click the Workgroup Manager Settings to open its properties.

Applications Properties

The Applications Properties settings allow you to control access to specific applications and
paths to applications using digital signatures.

You can apply Application Properties settings under both Computer Configuration and
User Configuration.

There are two tabs:

e Applications tab
e Options tab

Applications tab

The Application settings control which applications are allowed to run on macOS.

1. Select the Manage mode: Never, Once, or Always.

2. Select Restrict which applications are allowed to launch if you want to disallow
applications thus restricting the applications the user can access.

3. Application restrictions are controlled by means of folder paths. Group Policy does not
currently support application management using digital signatures, therefore to allow
or prevent users from launching an application, add the application or the path to the
application to one of two lists:

» Disallow applications within these folders.

Add folders containing applications that you want to prevent users from
opening. All applications in sub-folders of disallowed applications are also
disallowed.

e Allow applications within these folders.
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Add folders containing applications that you want users to launch. If an
application or path to the application appears in both the Disallow and the
Allow lists, then the Disallow list takes precedence and the user is not
allowed to launch the application.

If an application does not appear in either of these lists, the user can not launch the
application.

4. Click Add to open the New Application Item dialog. You can type the absolute
UNIX path or you can click Remote Browse to log into a remote macOS machine (by
means of SSH) and browse for the target folder. It displays recently specified paths.
To reuse a recently specified path, double-click the item in the list.

NOTE: Both disallow and allow paths support the %HOME% macro-expansion to the
user's UNIX home directory. For example, to restrict a user from running applications in
their home directory, specify %aHOME%. This macros is only supported by user policies;
machine policies do not support this macro type.

Options tab

The Options settings control macOS server settings. For example, you can choose
whether to allow a user to use the App Store. If set to false, a user that attempts to use
the app store will receive a message like the following: You don't have permissions to
use the App Store.

1. Select the Manage mode: Never, Once, or Always.
2. Select the check boxes to enable the features you want to enable.
» Allow use of Game Center
e Allow multiplayer gaming
* Allow adding Game Center friends
» Allow Game Center account modifications
e Allow App Store app adoption
e Allow Safari AutoFill
« Allow software update notifications
 Require admin password to install or update apps
» Restrict App Store to MDM installed apps and software updates

Dock Properties

On macQOS, the Dock is similar to a tool bar on other operating systems. In addition to
showing which applications are running, the dock provides quick shortcuts to applications,
folders and documents as well as system controls. Dock settings allow you to adjust the
behavior of the user’s Dock and specify which items appear in it.

You can apply Dock Properties settings under both Computer Configuration and User
Configuration.
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Dock Items tab

Dock Items tab settings control the applications, files and folders that are displayed on
the user's Dock and support the following management modes: Never, Once, Always.

You can insert three types of items into the user's Dock: Applications, Documents and
Folders. The Applications list controls which applications are inserted. The Documents
and Folders list controls documents and folders that are inserted into the user's Dock.
Click Add to select the items to insert in the Dock. You can drag the items within the list to
change the order in which they appear on the Dock.

In addition to standard UNIX paths, you can specify a network share by using the
following syntax:

cifs://<server hostname>/<share name>

Folder paths support two types of macro-expansions. First, the %@ macro expands to the
user's UNIX name. Additionally, you can expand any Active Directory attribute using the
%«<attributename>% macro. For example, to add the user’s network home directory to the
dock, specify %homeDirectory%. You can get the value for any user attribute using the

% <attributename>% macro. These macros are only supported by user policies; machine
policies do not support either of these macro types.

The following options are also supported:

 Merge with the user's Dock

Select to merge the specified items into the user's Dock. If you do not select this
option, the specified items replace the user's Dock.

 Add other folders:

Select to add predefined folders to the user's Dock. Safeguard Authentication
Services supports My Applications and Documents.

Dock Display tab

Dock Display tab settings allow you to configure options that affect the visual display of
the user's Dock and support the following management modes: Never, Once, Always.

The following options are supported:
e Dock Size
Select to control the size of the Dock window on the user's Desktop.
* Magnification

Select to control the size of magnification when the mouse cursor hovers over an
item on the Dock.

+ Position on screen

Select this option to control where on the screen the Dock is anchored. Options
include Bottom, Left and Right.

e Minimize Using
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Select to control the visual effect used when applications are minimized to the Dock.
Options include Genie and Scaled.

 Animate opening applications
Select to animate (bounce) the application icons on the Dock as the application loads.
e Automatically hide and show the dock

Select to hide the Dock automatically. When you position the cursor over the Dock
it displays itself automatically. Leave this option deselected leave the Dock visible
at all times.

Energy Saver Properties

The Energy Saver Properties settings helps you save energy and battery power by
managing wake, sleep, and restart timing.

You can apply Energy Saver Properties settings only under Computer Configuration.

Desktop tab

The Desktop tab settings control energy usage settings for macOS and support the
following management modes: Never, Always.

You can use preset settings by moving the slider anywhere from Minimum Energy Usage
to Maximum Performance. When you set the slider to Custom you can customize all
aspects of the energy usage settings.

The following desktop settings options are supported for both macOS and macOS Server.
Settings on the OS X tab apply to macOS workstations. Settings on the OS X Server tab
apply to macOS Servers.

e Put the computer to sleep when it is inactive for

Configure how long you want the system to wait before putting the computer to sleep
to save power. Inactivity means no keyboard or mouse input.

e Put the display to sleep when the computer is inactive for

Select to control how long you want the system to wait before putting the display to
sleep. Inactivity means no keyboard or mouse input.

e Wake when the modem detects a ring
Select to configure the computer to wake from sleep when the modem detects a ring.
« Wake for Ethernet network administrator access

Select to configure the computer to wake from sleep if an administrator attempts
remote access.

* Restart automatically after a power failure

Select to configure the computer to automatically start when power is restored after
a power failure.
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e Put the hard disks to sleep when possible
Select to configure the system to attempt to power down hard disks.
e Allow the power button to sleep the computer

Select to configure the computer to go to sleep when a user presses the
power button.

Portable tab

Portable tab settings control energy usage settings for macOS portable devices and
support the following management modes: Never, Always.

You can use preset settings by moving the slider anywhere from Minimum Energy Usage
to Maximum Performance. When you set the slider to Custom you can customize all
aspects of the energy usage settings.

Safeguard Authentication Services supports the following Portable Settings options for both
Adapter and Battery powered situations. Settings on the Adapter tab apply when the
portable device's power adapter is plugged in. Settings on the Battery tab apply when the
portable device is running on battery power.

e Put the computer to sleep when it is inactive for:

Select to control how long you want the system to wait before putting the computer
to sleep to save power. Inactivity means no keyboard or mouse input.

e Put the display to sleep when the computer is inactive for:

Select to control how long you want the system to wait before putting the display to
sleep. Inactivity means no keyboard or mouse input.

e Wake when the modem detects a ring
Select to configure the computer to wake from sleep if the modem detects a ring.
« Wake for Ethernet network administrator access

Select to configure the computer to wake from sleep if an administrator attempts
remote access.

+ Restart automatically after a power failure

Select to configure the computer to automatically start when power is restored after
a power failure.

e Put the hard disks to sleep when possible
Select to configure the system to attempt to power down hard disks.
* Processor Performance

Select to control the processor performance. The higher the performance setting the
more power used. Options include: Highest, Automatic and Reduced. Automatic
will attempt to use reduced power when the computer is running on battery power.
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Battery tab

Battery tab settings control battery status display and support the following management
modes: Never, Always.

To show the battery status in the menu bar select the Show battery status in the menu
bar option.

Schedule tab

The Schedule tab settings control automatic startup and shutdown for macOS
workstations and servers. They support the following management modes: Never,
Always.

The Schedule settings allow you to configure managed computers to start up or shutdown
according to a specific schedule. For example, you might configure certain computers to
sleep on Friday night and wake up early Monday morning.

To force the computer to start up or wake, select the Startup or wake option and set the
frequency and the time of day.

To force the computer to shut down or sleep check the box and select either Shutdown or
Sleep option from the drop-down then set the frequency and time of day.

Finder Properties

Finder is the macOS Window manager and file system browser. Finder Settings allow you to
configure the way Finder works.

You can apply Finder Properties settings under both Computer Configuration and User
Configuration.

Preferences settings control features and functionality of Finder.

1. Select the Manage mode: Never, Once, or Always.
2. Select whether to have Finder operate in normal or simple mode:
a. Use normal Finder.

b. Use Simple Finder. In simple mode, users cannot launch applications or files
from a Finder window. They are limited to what is accessible from the Dock. In
addition, users cannot create folders, delete files or mount network volumes in
simple mode. If you select Use Simple Finder, you can not specify any other
options because they do not apply to a simplified Finder environment.

3. Select items under Show these items on the desktop to display an icon on the
user's Desktop for each selected item. Options include: Hard disks, External
disks, CDs, DVDs, and iPods, and Connected servers.

4. For New Finder window shows, set the default view for New Finder windows. To
show the user's home directory, select Home. To show the computer view including
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mounted volumes select Computer.
5. Additional selections include:

» Always open folders in a new window: Select to open a New Finder
window each time a user opens a new window.

e Always open windows in column view: Select to automatically open new
windows in column view.

« Show warning before emptying the Trash: Select to prompt users to
confirm before moving items to the Trash.

 Always show file extensions: Select to display file extensions in
Finder views.

Login Properties

The Login Properties setting controls the appearance and behavior of the macOS
login window.

You can apply the Login Properties settings under both Computer Configuration and
User Configuration. However, the Items tab is only available in Users Configuration.

Window tab

The Window tab settings of the Login Properties control the appearance of the login
window such as the heading, message, which users are listed if the "List of users" is
specified, and the ability to restart or shut down. Window tab settings supports the
following management modes: Never, Once, Always.

The following options are supported:
 Heading

Selecting this box allows the user to click the time area of the menu bar to toggle
through various computer information values such as hostname, IP address, and
system version.

Apparently this changed around 10.10, but I don't think anyone realized it.
« Message
Enter a message to display in the login Window.
o Style
Set the following options to modify the login window style:
e Name and password text fields
To only display the user name and password text boxes.
o List of users able to use these computers

To display a graphical list of users that are allowed to log in.
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NOTE: Users can click the account to use for log in and will be prompted for a
password. You can set additional options to control which users are displayed
in the list.

e Show Other
To allow users to log in using the name and password text fields.
e Show Restart
To display the restart button in the login window.
e Show Shut Down
To display the shut down button in the login window.
 Show Sleep

To display the sleep button in the login window.

Options tab

The Options tab of the Login Properties controls miscellaneous login-related options and
support the following Manage Modes: Never, Always.

The following options are supported:

Show password hint when needed and available

All Safeguard Authentication Services users always have a password hint of Active
Directory Domain Password by default. This hint is configurable in the Safeguard
Authentication Services configuration policy. Users are never allowed to set a
password hint on a Safeguard Authentication Services account. Local or non-
Safeguard Authentication Services accounts may have a password hint which was
intentionally set by the user to remind them of their password.

Enable automatic login

Select to configure the operating system to boot directly to the desktop without
presenting the user with a login screen. The operating system boots using the
automatic login account configured locally under System Preferences, Accounts.

Enable console login

By default users can type >console at the login window to drop to a terminal login.
This setting allows you to disable the ability to drop to a terminal login.

Enable Fast User Switching

Select to display the logged in user's name in the right-hand corner of the desktop.
Selecting on the user name allows the user to switch to another account without
logging out of their current desktop session.

Log out users after X minutes of inactivity

Select to automatically log out a user if he has been inactive for the specified number
of minutes.

Local administrators may refresh or disable management
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Select to allow administrators to disable or refresh login window management
settings.

+ Set computer name to computer record name

This setting affects the computer’s Bonjour name. The new Bonjour name is name-
#.local where name is the computer record name you specify and # uniquely
identifies the computer if there are several computers with the same Bonjour name.

« Enable external accounts

Select to store external accounts on removable storage devices such as a thumb-
drive. You must insert the removable device before an external account can log in.

- Enable guest account

Select to enable a guest account to log in without a password. When the guest user
logs out, the home directory, documents and settings are removed from the system.

« Start screen saver after X minutes

Select to modify your screen saver setting.

Access tab

The Access tab settings of the Login Properties control which users are allowed to log in
and support the following management modes: Never, Always.

Safeguard Authentication Services provides unified access control across all supported
UNIX platforms including macOS. Because of this, use the Safeguard Authentication
Services access control policies to manage access control. The access control policies are
found in the Access Control node in the Quest Software folder under UNIX Settings.

The following option is supported:

e Local-only users may login

Select to allow local users to log in; leave this option deselected to only allow Active
Directory users to log in.

Scripts tab

The Scripts tab settings of the Login Properties control scripts that run at login and
logout; and, support the following management modes: Never, Always.

You can specify shell scripts that you want to run when a user logs in or out on macOS.
Scripts are stored in the policy settings so you can browse to local files or remote hosts to
select the script to use. Scripts configured through Group Policy run as root with the trust
value of FullTrust.

| NOTE: Test scripts thoroughly before deploying them with Group Policy.

The following options are supported:

@NE IDENTITY Safeguard Authentication Services 6.1 macOS Administration Guide a3

Quest Group Policy for macOS



e Login script
Specify the script to execute when the user logs in.
* Also execute the client computer's LoginHook script

Select to allow the LoginHook script to run. The LoginHook script is a locally
configured script that runs at login.

e Log-Out script
Specify the script to execute when the user logs out.
* Also execute the client computer's LogoutHook script

Select to allow the LogoutHook script to run. The LogoutHook script is a locally
configured script that runs at log-out.

Items tab

The Items tab settings of the Login Properties, control items that are started
automatically when a user logs in and support the following management modes: Never,
Once, Always.

| NOTE: The Items tab is only available in Users Configuration.
To run items automatically when a user logs in, see Adding login items.

The following options are supported:

e User may add and remove additional items

Select to allow users to add and remove additional items by means of local
configuration. You can only configure this option if the management mode is
set to Always.

e User may press Shift to keep items from opening

Select to allow users to press shift to prevent items from opening automatically. You
can only configure this option if the management mode is set to Always.

 Merge with user's items

Select to merge the configured items with the user's items. You can only configure
this option if the management mode is set to Once.

Adding login items

This section describes how to add login items that start automatically from the Items tab.

To add login items

1. Click Add to type the full path to the volume, document, folder or application.
Alternatively, you can click Browse to browse for the path to the item on a remote
macOS system. Items open in the order they are listed.

2. Select the Hide option and to start the item in a minimized state on the Dock. This
prevents screen clutter when starting several items while still making the items easily
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accessible.

3. Click Apply.

Media Access Properties

The Media Access Properties settings allows you to control settings for and access to
AirDrop, CDs, DVDs, the local hard disk, and external disks (for example, floppy disks and
FireWire drives).

You can apply Media Access Properties settings under both Computer Configuration and
User Configuration.

Media Access tab

The Media Access tab settings control access to media devices.

For the media settings, select the Manage mode: Never, Once, or Always.

The following options are supported:

 Disc Media

Select which removable disc media devices you want to allow users to access. If you
select Require Authentication, the user needs to provide credentials before he can
access the disc media.

Select if you want to Allow file transfer (to and from iOS and iPadOS) using
Finder or iTunes.

Select whether to Eject all removable media at logout.
Other Media

Select other media devices you want to allow users to access. If you select Require
Authentication, the user needs to provide credentials before he can access the
media. If you select Read-Only, the user cannot write to the media.

Select if you want to Allow file transfer (to and from iOS and iPadOS) using
Finder or iTunes.

Select whether to Eject all removable media at logout.
Network Access
Select to allow Air Drop.

Select if you want to Allow file transfer (to and from iOS and iPadOS) using
Finder or iTunes.

Select whether to Eject all removable media at logout.
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Network Properties

The Network Properties settings allow you to configure settings for hosts and domains to
bypass and disable Internet Sharing, AirPort, and Bluetooth.

You can apply the Network Properties settings under both Computer Configuration
and User Configuration. However, you can only apply the Sharing & Interfaces
functionality in the Computer Configuration node.

Sharing & Interfaces tab

The Sharing & Interfaces tab settings of the Network Properties control access to
network features and support the following management modes: Never, Always.

The Sharing & Interfaces settings are only configurable in the Group Policy Computer
Configuration node.

The following options are supported:

e Disable Internet Sharing
» Disable AirPort
» Disable Bluetooth

Parental Controls Properties

The Parental Controls Properties settings allow you to hide profanity in Dictionary, limit
access to websites, or set time limits or other constraints on computer usage.

You can apply the Parental Controls Properties settings under both Computer
Configuration and User Configuration.

1. For content filtering, the Manage mode of Always is typically selected. Also
available are the modes of: Never or Once.

2. Select the following check boxes, as desired:

- Hide profanity in Dictionary: Select to hide profanity in the Dictionary
application.

« Limit access to websites by: Select to filter websites explicitly or by using
the built-in adult content filter.

3. If you selected Limit access to websites by, you can filter content in one of two
ways: explicitly or with the built-in adult content filter.

e To filter explicitly:

a. Select allowing access to the following websites only from the
drop-down box. The view now shows a single box with buttons on the
right side.
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b. Allowed websites will be displayed in the user's browser. You can
organize the websites using folders. Click Add folder to add a folder.
Type the name of the folder and press Enter.

c. Click Add website. The Web Site dialog appears. Here you can type the
display name for the web site and the web address.

d. Type the web site display name in the box labeled Web site title type
the web site URL in the box labeled Address.

e. Click OK. he new website is displayed under the folder. You can drag
items to move them to different folders.

f. Add additional folders and websites as needed, then click OK to save
settings and close the Parental Controls dialog.

o To filter with the built-in adult content filter.

a. Select trying to limit access to adult websites from the drop-down
box. The view now shows two list boxes with buttons on the right.

b. The system tries to limit access to adult websites using a built-in
algorithm. You can override the behavior of the system filter by
specifying websites that should always be allowed or always be denied.

c. To allow a site, click the Add button under the Always allow sites at
these URLs heading. Type the URL of the website and press Enter.

A new website is added to the allow list.

d. To deny a site, click the Add button under the Never allow sites at
these URLs heading. Type the URL of the website and press Enter.

e. Click OK to save settings and close the Parental Controls
Properties dialog.

4. Click OK.

Printing Properties

The Printing Properties settings allow you to specify network printers you want to
configure for use on client computers.

You can apply the Printing Properties settings under both Computer Configuration
and User Configuration.

Printers tab

The Printers tab settings of the Printing Properties, control printers that are
configured for use on client computers and support the following management modes:
Never, Always.

Printers tab settings allow you to set up printers that will be available on client computers.

The following options are supported:
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« Allow printers that connect directly to user's computer

Select to allow printing to printers that connect directly to the user's computer
through FireWire or USB ports etc.

 Require an administrator password

If you have selected the Allow printers that connect directly to user's
computer option, select this option to require an administrator password in order to
print to a printer that is connected directly.

Adding a printer
This section describes how to add a printer that will be available on macOS clients.

To add a printer

1. To determine the proper printer settings, One Identity recommends to first configure
the printer on a single macOS host system. Add the printer as described in the
macOS documentation and verify that you can print with it.

2. Once you set up the printer, open the printer properties, and take note of the
following settings: Name, Location, Kind and URL. The following images show
where you can find these settings:

N.YeXo! Print&uFas
«[» | Showall Q

‘ Printers \

Laser]et

Location: Near the break room

Kind: HP Laserjet M4345 MFP
Status: Idle

[: Open Print Queue... ) (Optinns & Supplies... :]

[+[-|
Default Printer: | Last Printer Used I-H
Default Paper Size in Page Setup: [ US Letter I-H
P @
Click the lock to prevent further changes.
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3. To determine the URL, click Options & Supplies:

f General | Driver Supply Levels |

Name: Laser|et

Location: | Mear the break room

Queue Name: mox_0
Host Name: localhost

Driver Version: 4.0.0.080

URL: mdns://slcpriw01._printer._tcp.local. I

[Cancel] [ oK )

This is all of the information you will need to configure the printer for all of your
macOS systems using Group Policy.

4. In Group Policy Management Editor, open the Printing policy (Computer
Configuration > Policies > Mac OS X Settings > Workgroup Manager
Settings) and select the Printers tab.

Select the Always management mode.

. Click Add to add a new printer to the policy. The Add printer dialog appears. Enter
the Name, Location, Model and Printer URL, then click OK. The best way to
determine the printer URL is to configure a printer on a macOS client and enter the
URL specified in the Options and Supplies dialog. See step 1.
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Add printer... x|
Name: I Laser Jet Browse AD... |

Location: I Mear the break room

Model: I HP Laser Jet M4345 MFP

Printer LRL: I mdns: /fslcpriwd 1. _print, _tcp.local,
What's this?

| Ok [_: I Cancel

You can also add SMB printers by browsing for the printer in Active Directory.

If you want the selected printer to be the default printer click Make Default.

If you want to require the user to enter an administrator password before printing to
the selected printer, click the Require an administrator password option.

9. Click OK to save settings and close the Printing dialog.

Footer tab

The Footer tab settings of the Printing Properties control footer display and formatting.
They support the following management modes: Never, Always.

Footers are additional information appended at the bottom of each printed page containing
the date and the name of the user that initiated the print job.

The following options are supported:

* Print Page Footer
Select to enable page footers.
e Include MAC address

Select to include the client computer's network card MAC address in the footer
information when page footers are enabled.

e Font name
Select the page footers font name.
* Font size

Select the page footers font size.

Software Update Properties

The Software Update properties allow you to configure the Software Update server that
managed clients use for downloading updates and purchasing or installing apps.
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You can apply the Software Update properties settings under both both Computer
Configuration and User Configuration.

Software Update tab

The Software Update tab settings of the Software Update Properties control the
Software Update server that managed clients use to download updates.

You can cache software updates on your local intranet using a local Software Update
server. This can help reduce network bandwidth usage and speed update deployment in
your network. Use this setting to instruct managed clients to use the local Software
Update server.

Select the Manage mode: Never, Once, or Always.

The following options are supported:

o Software Update server to use

Specify the URL of the software update server. The URL must be in the form
http://<server hostname>:< port >/index.sucatalog

« Allow installation of macOS beta releases
e Allow non-admin users to purchase apps and install software updates
o Automatically install macOS updates

« Automatically install app updates from the App Store

System Preferences Properties

The System Preferences Properties settings allow you to control which items appear in
the System Preferences of managed clients. This allows you to restrict which System
Preferences configurations users can access.

You can apply the System Preferences Properties settings under both Computer
Configuration and User Configuration.

System Preferences tab

The System Preferences tab settings of the System Preferences Properties control
which items appear in System Preferences on managed clients.

You can control which items appear in System Preferences on managed clients. The
System Preferences tab displays a list of System Preferences items.

e Select the Manage mode: Never, Once, or Always.

e Select whether the items in the preferences pane that are checked are Enabled or
Disabled. For example, if you select the checked items are Disabled then select
Users & Groups, the User & Groups item is disabled and the selection is
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unavailable on the System Preferences pane.
e Click Show All to select and display all items.

e Click Show None to clear and hide all items.

Time Machine Properties

The Time Machine Properties settings allow you to control the Time Machine application
which provides network backups of installed applications, preferences, documents and local
account data. For more information about Time Machine, refer to the Apple documentation.

You can apply the Time Machine Properties settings only under the Computer
Configuration.

Time Machine tab

The Time Machine tab settings control the Time Machine application and support the
following management modes: Never, Always.

Time Machine is an application that performs network backup of local machine
applications and data.

The following options are supported:

 Backup Server

Specify the URL of the Time Machine backup server in the following format:
afp://someserver.company.com/Backups/. Refer to the Apple documentation for more
information about AFP and Time Machine backup servers.

e Back up

Specify which volumes to back up. You can choose to back up Startup volume only
or All local volumes.

» Skip system files

Select to skip system files. System files are operating system files installed when you
install macOS. Selecting this option significantly reduces the amount of storage space
used for backups. However, if you do not back up system files, you will need to install
the operating system when performing a full restore.

e Backup automatically
Select this option to force automatic backups.
e Limit total backup storage to

Enter the backup storage limit in megabytes. If the backup limit is reached, no more
data is backed up.
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Wireless Profile Properties

Wireless settings allow you to configure networks and profiles used by AirPort on macOS
systems. The Wireless Profile Properties settings allow you to control wireless user
profiles for macOS.

To open the Wireless Profile properties page

1. Inthe Group Policy Object Editor, navigate to User Configuration > Policies >
Mac OS X Settings > Profile Manager Settings.

Wireless Networks apply only to users.
2. Double-click the Wireless Networks node.

Adding wireless profiles

The Wireless Profiles tab settings control user options associated with wireless networks.

For the AD certificate and certificates profile, you can use a certificate created by vascert
to work with Network preferences. One scenario for this is for a computer to use QoS
supportive adaptive polling (QAP) protocol for the wireless network. For more information,
see For more information, see vascert command reference on page 68..

To add wireless profiles

Click the Up or Down buttons to reorder the wireless profiles. Wireless profiles are added
to the user profiles list on macOS systems in the order listed in the policy.

1. From the Wireless Networks tab, click Add to open the Wireless Profiles dialog.
2. On the Networks tab:
Enter the name of the wireless profile in the Name box.

b. Enter the SSID of the wireless network to which this profile applies in
the SSID box.

c. Select the type of wireless network from the Security Type drop-down list.

d. Select the authentication type options that apply to this profile from the
Protocols list.

e. Select Hidden Network to allow users to join a network whose name is
not broadcast.

f. Select Auto Join so the network is joined automatically. If unselected, the
user must click the network name to join it.

3. On the Proxy tab:
a. Select the Proxy settings from the drop-down list. None is the default.
b. Enter the Proxy server and port.

c. Enter the Username (optional).
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d. Enter the Password (optional).

e. Enter the Proxy Server URL.

f. Select Allow direct connection if PAC is unreachable, if desired.
4. On the Protocols tab:

a. Inthe EAP-FAST section, identify the configuration of Protected Access
Credentials (PAC) by selecting any combination of the following:

+ Use PAC

e Provision PAC

e Provision PAC Anonymously
Select Allow only two RAND values with EAP-SIM, if desired.
Select the TTLS authentication protocol from the drop-down list.

Identify Externally visible.

® 2o o

Select the TLS minimum version from the drop-down list.
f. Select the TLS maximum version from the drop-down list.
5. On the Identity and Authentication tab:

a. Select Use two factor authentication, if you will use a second
authentication.

b. Select Authenticate with host's directory credentials, if desired. If
selected, enter the Username and Password.

c. InIdentity Certificate, note that you must have vascert on the client to use
certificate identity. Select any combination of check boxes, as appropriate:

e Create a certificate identity with vascert
e Allow all apps to access the private key
e Allow a user to extract the private key from the keychain

Preference Manifest settings

The Preference Manifests node lists applications and settings that you can manage
using preference manifests. Policy items contained in this node are specific to the
Macintosh operating system. A preference manifest is a file that describes application
settings and makes them manageable. Application developers create preference manifest
files to make their application’s settings available for management through the
Preference Manifests node.

When you install Group Policy console extensions, it creates preference manifests in sysvol
at the following location:

Policies\Quest Software\Preference Manifest
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In order to reduce GPO size, Preference Manifest files are stored in the GPT under the
Policies\Quest Software\Preference Manifest folder. All of the Preference Manifest files
found there are displayed in the Preference Manifests node. If the folder does not exist
in the GPT, Preference Manifest files are loaded from the local installation directory.

Apple provides preference manifests for many built-in applications and systems. Group
Policy includes preference manifests for Microsoft Office applications and other common
third-party applications. You can also import custom preference manifests for policy
configuration. The Safeguard Authentication Services installation process adds macOS,
Workgroup Manager, and Preference Manifest Settings nodes to both the Computer
Configuration and User Configuration nodes and stores all the Safeguard Authentication
Services for macOS Desktop policies there.

Adding a preference manifest

You can add a preference manifest file to the Preference Manifests node in Group Policy
Object Editor (GPOE).

To add a preference manifest

1. Right-click on the Preference Manifests node and select Add/Remove
Preference Manifests from the menu.

The Add/Remove Preference Manifest dialog is displayed.

Current Preferancs Manifests:

Palicy Mame Domdain

Apple Crash Reporter
Apple Deskiop Services
Apple Terminal

Apple Time Machine
Dashboard

Deskiop Picture

Digital Hub (Default COJDVD Actions)
Finder

Haome Sync

Hot Corner Achons
Internet Configuration
Mal

Mai-10.6

Managed Menu Extras
Microsaft Excsl 2008

com.apple. CrashRep. ..

com.apple. desktopse. .,
coem.apple. Terminal

com. apple. TmeMachine

com.apple.dashboard
com.apple. desktop
coen. apple._ digibub
com.apple. finder

com. apple.homeSync
com.apple. dode

com. apple._intermet
com.apple.mail mana. ..
con. apple. mail

Coim. apple. modend. ...
com.microsoft, Excel

10/07/2004 03:03:08
10072009 03:03:08
10/07/2004 03:03:08
10/07/200:9 03:03:08
10/12/2009 01:03:25
10122009 01:03:26
10/07/2009 03:03:08
10/07 2009 03:03:08
10072009 03:03:08
1007720049 03:03:08
10/07/2003 03:03:08
10/07 2009 03:03:08
10/07/200:9 03:03:08
10072009 03:03:08
10/07/2009 03:03:08

| Load Defoults |

[ o ]

2. Click Add to browse for the preference manifest file that you want to load.
3. Click Load Defaults to reset the list to the default set of preference manifests.

4. Click Remove to remove the selected preference manifests.
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5. Click OK to save changes and close the Add/Remove Preference Manifest dialog.

The Preference Manifest view is updated to reflect the changes.
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Certificate Autoenroliment

Certificate Autoenrollment is a feature of Safeguard Authentication Services based on
Microsoft Open Specifications. Certificate Autoenroliment allows macQOS clients to take
advantage of existing Microsoft infrastructure to automatically enroll for and install
certificates. Certificate policy controls which certificates are enrolled and what properties
those certificates will have.

With Certificate Autoenrollment, a public/private key pair is automatically generated
according to certificate template parameters defined in Group Policy. The public key is sent
to the Certification Authority (CA), and the CA responds with a new certificate
corresponding to the public key, which is installed along with the private key into the
appropriate system or user keychain on the Mac client.

You can use Group Policy to automatically configure which certificate enrollment policy
servers to use for Certificate Autoenrollment and to periodically run Certificate
Autoenrollment.

This section explains the system requirements for Certificate Autoenrollment and walks you
through policy setup as well as client-side usage and troubleshooting.

Certificate Autoenroliment on macOS

Most of the Certificate Autoenrollment code is implemented in Java. After this code has
successfully requested a certificate from a CA, it invokes platform-specific code to store the
private key and certificate in a suitable way for the operating system or for particular
applications. This platform-specific code is implemented as a shell script, certstore.sh, in
the /var/opt/quest/vascert/script directory.

The certstore.sh script is a platform-agnostic front end that chooses and loads a platform-
specific back end script. For macQOS, the back end script is certstore-mac.sh. This script
provides a fully functional implementation that uses the /usr/bin/security tool to
integrate with macOS keychains.
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Certificate Autoenroliment
requirements and setup

Prior to installing One Identity Certificate Autoenrollment, ensure your system meets the
following minimum hardware and software requirements.

Table 2: Certificate Autoenroliment: Minimum requirements

Component

Requirements

Java unlimited
strength
policy files

Additional
software

Rights

For more information, see For more information, see Java requirement:
Unlimited Strength Jurisdiction Policy Files on page 59..

Certificate Autoenrollment depends on services provided by a Microsoft
Enterprise Certificate Authority (CA) in your environment.

In addition to Active Directory and an Enterprise CA, you must install the
following software in your environment:

e Microsoft Certificate Enrollment Web Services

In order for Certificate Autoenrollment to function on client computers,
you must configure the following policies:

» Certificate Services Client - Auto-Enrollment Group Policy

o Certificate Services Client - Certificate Enrollment PolicyGroup
Policy

» Certificate Templates

Additionally, you must configure Java 1.8 (or later) as the default JVM for
your system.

NOTE: Install JRE (Java Runtime Environment) on all platforms other
than macOS. macOS requires JDK (Java Development Kit). Typing java
on the command line provides instructions.

e For Linux operating system, install JRE 1.8 (or later).

» For macOS (that is, your operating system tells you to get it from
Oracle), install the JDK.

Enterprise Administrator rights to install software and configure Group
Policy and Certificate Template policy (only if Certificate Autoenrollment
is not already configured for Windows hosts in your environment.)

@NE IDENTITY Safeguard Authentication Services 6.1 macOS Administration Guide 58

by Quest Certificate Autoenrollment



Java requirement: Unlimited Strength
Jurisdiction Policy Files

By default, most JRE and JDK implementations enforce limits on cryptographic key
strengths that satisfy US export regulations. These limits are often insufficient for
Certificate Autoenrollment and may lead to "java.security.InvalidKeyException: Illegal key
size" failures. The "Java Cryptography Extension (JCE) Unlimited Strength Jurisdiction
Policy Files" can be installed to remove these limits and enable Certificate Autoenrollment
to function properly.

Do I need the Java Cryptography Extension (JCE) Unlimited Strength
Jurisdiction Policy Files?
In general the answer is: Yes, these files are needed.

Java 9 and above do not require these files, but Java 8 relies on these files.

Obtaining and installing the policy files

For Java implementations from IBM, the policy files are usually bundled with the JDK but
not the JRE, so it may be more convenient to install the JDK rather than just the JRE.
Once the JDK is installed its demo/jce/policy-files/unrestricted directory should
contain two JAR files:

e local_policy.jar
e US_export_policy.jar
Use these files to replace the corresponding JAR files in the jre/lib/security directory

of the JDK. Alternatively, the "Unrestricted SDK JCE policy files" can be downloaded
from ibm.com.

For Java implementations from Sun, Oracle and Apple and for Open]DK
implementations, the policy files must be downloaded from Oracle. Java 8 version
requires its own policy files:

» Java 8: http://www.oracle.com/technetwork/java/javase/downloads/jce8-
download-2133166.html

This download is a zip file that includes a README.txt and two JAR files, local _
policy.jar and US_export_policy.jar. Use these JAR files to replace the corresponding
files in the JRE or JDK:

e JRE: The lib/security directory usually holds these files.
e IDK: The jre/lib/security directory usually holds these files.
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Installing certificate enroliment web
services

The following procedures walk you through the installation and configuration of the
required components. If Certificate Autoenrollment is already configured for Windows hosts
in your environment, you can skip to Using Certificate Autoenrollment on page 62.

To perform these procedures, you need Enterprise Administrator rights to install software
and configure Group Policy and Certificate Template policy.

NOTE: Microsoft has documented all of the steps to install and configure Certificate
Enrollment Web Services.

To set up certificate enrollment web services

1. Review the requirements as specified by Microsoft at:
http://technet.microsoft.com/en-us/library/dd759243.aspx.

2. Follow the instructions at: http://technet.microsoft.com/en-
us/library/dd759241.aspx to install the Certificate Enrollment Web Service.

3. Follow the instructions at: http://technet.microsoft.com/en-
us/library/dd759214.aspx to install the Certificate Enrollment Policy Web Service.

4. Follow the instructions at: http://technet.microsoft.com/en-
us/library/dd759140.aspx to configure server certificates for HTTPS.

Certificate Enrollment Web Services are now installed. Next, you will configure policy
settings to enable Certificate Autoenrollment.

Configuring Certificate Services Client -
Certificate Enrollment Policy Group Policy

If you are using Group Policy, you must configure the Certificate Enrollment Policy Web
Service group policy setting to provide the location of the web service to domain members.
Otherwise, you must manually configure the server URL on each system as explained in
Using Certificate Autoenrollment.

To configure certificate enrollment policy

1. On the web server that hosts the Certificate Enroliment Policy Web Service, open
Server Manager.

In the console tree, expand Roles, then expand Web Server (I1IS).
3. Click Internet Information Services (IIS) Manager.

In the console tree, expand Sites, and click the web service application that begins
with ADPolicyProvider_CEP.
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@ N o u

10.

11.
12.
13.

14.

15.

16.

17.

18.

NOTE: The name of the application is ADPolicyProvider_CEP_AuthenticationType,
where AuthenticationType is the web service authentication type.

Under ASP.NET, double-click Application Settings.
Double-click URI, and copy the URI value.
Click Start, type gpmc.msc in the Search programs and files box, and press Enter.

In the console tree, expand the forest and domain that contain the policy that you
want to edit, and click Group Policy Objects.

Right-click the policy that you want to edit, then click Edit.

In the console tree, navigate to User Configuration > Policies > Windows
Settings > Security Settings and click Public Key Policies.

Double-click Certificate Services Client - Certificate Enroliment Policy.
Click Add to open the Certificate Enroliment Policy Server dialog.

In the Enter enrollment policy server URI box, type or paste the certificate
enrollment policy server URI obtained earlier.

In the Authentication type list, select the authentication type required by the
enrollment policy server (Kerberos).

Click Validate, and review the messages in the Certificate enrollment policy
server properties area.

Click Add.

The Add button is available only when the enrollment policy server URI and
authentication type are valid.

In the Group Policy Object Editor, navigate to Computer Configuration > Policies
> Windows Settings > Security Settings and click Public Key Policies.

Repeat steps 11-16 for machine configuration.

Configuring Certificate Services Client -
Auto-Enrolilment Group Policy

If you are using Group Policy, you must enable Certificate Autoenrollment in Group Policy,
otherwise, Group Policy may disable Certificate Autoenrollment. If you are not using Group
Policy, Certificate Autoenrollment is enabled on each host by default.

To enable Certificate Autoenrollment using Group Policy

1.

On a domain controller running Windows Server open the Start menu and navigate
to Administrative Tools > Group Policy Management.

In the console tree, double-click Group Policy Objects in the forest and domain
containing the Group Policy Object (GPO) that you want to edit.

Right-click the GPO, and click Edit.

@NE IDENTITY Safeguard Authentication Services 6.1 macOS Administration Guide 61

Quest Certificate Autoenrollment



4. In the Group Policy Object Editor, navigate to User Configuration > Policies >
Windows Settings > Security Settings and click Public Key Policies.

Double-click Certificate Services Client - Auto-Enrollment.

Next to Configuration Model, select Enabled from the drop-down list to enable
autoenrollment.

Click OK to accept your changes.

In the Group Policy Object Editor, navigate to Computer Configuration > Policies
> Windows Settings > Security Settings and click Public Key Policies.

9. Repeat steps 5-7 for machine configuration.

Configuring Certificate Templates for
autoenroliment

Certificate enrollment is based on templates which define the properties of certificates
generated by the Certificate Authority (CA) when clients request certificates.

To create a new certificate template

1. On the server hosting your Enterprise CA, click Start, select Administrative Tools,
and click Certification Authority.

2. Inthe console tree, expand the CA root node, select Certificate Templates, and
click Manage.

3. Inthe Certificate Templates console, select the template that you would like to
enable for autoenrollment, or create a new template.

4. Double-click the template to open its properties and select the Security tab.

5. Add the users and machines that you want to automatically enroll for the certificate
and select the Autoenroll permission option.

6. Click Apply.

Using Certificate Autoenroliment

Certificate Autoenrollment is an automatic process that runs as-needed on client systems
according to Group Policy or according to manual configuration if you are not using Group
Policy. Certificate Autoenrollment typically requires no user interaction. After Certificate
Autoenrollment is complete, certificates appear in the user's keychain for user-based
enrollment or in the system keychain for machine-based enroliment.

Certificate Autoenrollment runs when:
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e Auserlogsin

e Group Policy machine processing occurs (at machine startup and periodically
thereafter)

e vascert trigger runs manually (for machine-based enroliment)

NOTE: Linux: Group Policy updates for users are disabled by default. If Group Policy is
used to configure Certificate Autoenrollment, ensure to enable it through configuration
variable UserPolicylLogonServices in vgp.conf. See man vgp.conf.

If Group Policy is in use and a Certificate Services Client - Auto-Enrollment Group
Policy indicates that Certificate Autoenrollment should occur, then the Certificate
Autoenrollment client runs. The Certificate Autoenrollment client then downloads and
evaluates Certificate Autoenrollment policy and uses this information to determine whether
any certificates should be enrolled.

On Linux, vascert automatic certificate update operates with three systemd services:

e vascert-impottrustedroots service: a system service for importing trusted root
certificates which gets triggered through /var/opt/quest/vascert/.catrigger file.

e vascert-machineapply: a system service for applying machine certificates. It gets
triggered with /var/opt/quest/vascert/.machinetrigger.

e vascert-userapply: a user service which gets started when the user login reaches the
default.target. It handles the automatic deploy of the user certificates. This user
service is enabled by default for all user by a systemd user preset "90-vascert-
userapply.preset".

The same functionality on macQOS is provided by the following services:
com.quest.qcert.ImportTrustedRoots.plist, com.quest.qcert.MachineApply.plist, and
com.quest.qcert.UserApply.plist.

Each of these steps can be invoked manually for testing and troubleshooting. To start
Group Policy manually, use the vgptool command. To run Certificate Autoenrollment, use
the vascert command. These command are installed in /opt/quest/bin.

Configuring Certificate Autoenrollment
manually

Once Certificate Autoenrollment is installed, you must configure your machine to use it. If
you are using One Identity Safeguard Authentication Services with Group Policy, then skip
the manual configuration described in this section as Group Policy performs these tasks
automatically.

NOTE: Group Policy functionality is not available when used with the Apple Directory
Services plug-in. When Group Policy is not available, you must manually configure
certificate enrollment policy servers and schedule machine certificate enrollment to run
on an interval if desired.
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Configure a machine for Certificate
Autoenroliment

Use the vascert command line utility to configure your machine for Certificate
Autoenrollment. Your computer must be joined to the Active Directory domain where your
certificate enrollment policy server resides.

NOTE: Unless you are using Group Policy, machine processing must be triggered
manually using the vascert trigger command. You can schedule this command to run at
an interval.

To configure your machine for Certificate Autoenroliment

1. Login as a root user or using sudo.
2. To configure a machine for Certificate Autoenrollment, run the following command:
/opt/quest/bin/vascert server add -r <policy-server-URL>

In this command, <policy-server-URL> is the actual HTTP URL for your certificate
enrollment policy server, for example:

https://example.com/ADPolicyProvider_CEP_Kerberos/service.svc/CEP

NOTE: You can configure more than one certificate enrollment policy server. If you
do so, Certificate Autoenrollment will choose the most appropriate server
automatically when performing certificate enrollment.

Configure a user for Certificate Autoenrollment

Use the vascert command line utility to configure a user for Certificate Autoenrollment. The
user must be an Active Directory user. Certificate Autoenrollment is not supported for local
users. Your computer must be joined to the Active Directory domain where your certificate
enrollment policy server resides.

NOTE: Certificate Autoenrollment will run automatically when users log in based on the
/Library/LaunchAgents/com.quest.qcert.UserApply.plist file. You can change this
behavior by modifying this file.

To configure a user for Certificate Autoenroliment

1. Login as a root user or using sudo.
2. To configure a user for Certificate Autoenrollment, run the following command:
/opt/quest/bin/vascert server add -u <username> -r <policy-server-URL>

In this command, <policy-server-URL> is the actual HTTP URL for your certificate
enrollment policy server, for example:

https://example.com/ADPolicyProvider_ CEP_Kerberos/service.svc/CEP
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NOTE: You can configure more than one certificate enrollment policy server. If you
do so, Certificate Autoenrollment will choose the most appropriate server
automatically when performing certificate enrollment.

Trigger machine-based Certificate
Autoenroliment

Normally Group Policy triggers Certificate Autoenrollment. If you are not using Group
Policy, use the vascert command line utility to manually trigger Certificate Autoenrollment
processing for the machine. This will result in certificates being added to the
System.keychain according to enrollment policy. You can schedule this command to run
periodically if desired.

To manually trigger Certificate Autoenrollment

1. Log in as a root user or using sudo.
2. To manually trigger Certificate Autoenroliment, run the following command:

/opt/quest/bin/vascert trigger

Certificate Autoenrollment will proceed in the background. When complete, newly enrolled
certificates will be installed in the System.keychain automatically. To troubleshoot
Certificate Autoenrollment, run the vascert pulse command as root.

Troubleshooting Certificate
Autoenrollment

To help you troubleshoot Certificate Autoenrollment, One Identity recommends the
following resolutions to some of the common errors, and methods for finding and correcting
configuration problems.

Certificate Autoenrollment process exited
with an error

As mentioned in the Certificate Autoenrollment on macOS section, some important
Certification Autoenrollment commands, such as vascert pulse, will not work until the
necessary platform-specific functionality has been implemented in certstore-DEV.sh. For
more information on modifying certstore-DEV.sh and a simple example script, see the
Examples and further explanation for modifying certstore-DEV.sh on Linux and UNIX
(284711) KB article.

@NE IDENTITY Safeguard Authentication Services 6.1 macOS Administration Guide 65

by Quest Certificate Autoenrollment


https://support.oneidentity.com/kb/284711/
https://support.oneidentity.com/kb/284711/

Until the certstore-DEV.sh script is modified, the following issues will happen when running
vascert pulse:

<VASCERT PULSE COMMAND>

$ vascert pulse

vascert: One Identity Certificate Autoenrollment version 1.1.0.750
Copyright 2017 Quest Software Inc. ALL RIGHTS RESERVED.

Processing enrollment policy: dcl.domain.com

Process exited with an error (Exit value: 1), command was:
[/var/opt/quest/vascert/script/certstore.sh, export-machine-certs,
/tmp/6353628018779558796pk12, mdzDFXBD7znDYDOS8B]

</VASCERT PULSE COMMAND>

The output shows which script vascert ran and the parameters passed to the script. As
previously mentioned, certstore.sh calls (on all platforms other than macOS) certstore-
DEV.sh. In the example above, certstore.sh calls into certstore-DEV.sh's
exportMachineCerts function. By default, that function only returns a 1 indicating an error
as shown here:

exportMachineCerts()

echo "=== UNIMPLEMENTED exportMachineCerts'()"' ==="

See the Examples and further explanation for modifying certstore-DEV.sh on Linux and
UNIX (284711) KB article for a deeper understanding of that function, expected
parameters, and an example for using that function. As long as that function returns '1',
autoenrollment will cease at this point and vascert will not enroll for a new certificate.
Because this is the first step of many, see the KB article for other functions that need to be
modified and examples on how to do so.

Enable full debug logging

You can enable full debug logging for all Certificate Autoenrollment components using the
vascert command line utility.

If debug logging is configured, Group Policy extensions, the vascert tool, and launchd write
log files in /Library/Preferences/com.quest.X509Enrollment/log for machine enrollment
and ~/Library/Preferences/com.quest.X509Enrollment/log for user enrollment. You can
enable debug logging for all of these components.

To enable debug logging

1. As root, run the following command to configure debug logging for all users:

/opt/quest/bin/vascert configure debug
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2.

To configure debug logging for a specific user, log in as that user and run the
same command.

NOTE: Enabling debug logging causes the vascert command to write debug
messages to a file in addition to stdout. Even after you enable debug logging, you
must set the debug level using the -d command line option when running vascert
commands manually.

When you are finished debugging, run the following command as root to turn off
debug logging for all users. One Identity recommends that you turn off debug logging
to improve performance and conserve disk space.

/opt/quest/bin/vascert unconfigure debug

To turn off debug logging for a specific user, log in as that user and run the
same command.

Pulse Certificate Autoenroliment processing

Use the vascert command line utility to manually perform Certificate Autoenrollment.

To perform Certificate Autoenrollment processing manually

1.

2.

Decide whether you want to pulse Certificate Autoenrollment for the machine or a
specific user.

To pulse Certificate Autoenrollment for the machine, run the following command as
root (or using sudo):

/opt/quest/bin/vascert pulse

NOTE: To pulse certificate enrollment for the machine, you must run the command
with root privileges. This is mostly useful for troubleshooting. In some cases (such
as when logging in by means of SSH), this will not result in successful certificate
enrollment because the System.keychain cannot export existing private keys
required for certificate renewal processing. If you just want to run Certificate
Autoenrollment processing for the machine and you are not interested in the
output, use vascert trigger instead.

To pulse Certificate Autoenrollment for a specific user, log in as that user and run the
following command:

/opt/quest/bin/vascert pulse

NOTE: Use the GUI to log in as the user. This ensures that the user's keychain is
unlocked so that enrolled certificates can be exported and imported. Logging in by
other means, such as SSH, is generally not sufficient and may lead to errors when
the certstore-mac.sh script invokes the /usr/bin/security tool.
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Manually apply Group Policy

If you are using One Identity Safeguard Authentication Services 4.1 (or later), Certificate
Autoenrollment is configured automatically by Group Policy. Use the vgptool command line
utility to manually apply Group Policy.

To manually apply Group Policy

1. Decide whether you want to apply machine policy or user policy.

NOTE: Machine policy affects the entire system; User policy only affects the
specified user.

2. To apply machine policy, enter the following command as root (or using sudo):
/opt/quest/bin/vgptool apply
The terminal displays policy processing results.

3. To apply user policy, enter the following command as root (or using sudo):
/opt/quest/bin/vgptool apply -u <username>

The terminal displays policy processing results.

Command line tool

vascert is the Certificate Autoenrollment command line tool for certificate enrollment. With
vascert you can configure various aspects of Certificate Autoenrollment. You can manually
trigger certificate enrollment processing. In addition, vascert is also helpful for
troubleshooting various network and authentication problems that may occur.

This command reference details the command line usage for vascert.

vascert command reference

vascert is the Certificate Autoenrollment processor.

Name

vascert

Synopsis

vascert [-d <debug level [1-6]>] [-b] [-h <command>] <command [command options]>

Overview

vascert is the Certificate Autoenrollment processor for Linux and macOS clients.
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Commands

To run vascert, specify one or more general options, then specify a specific command
which may have further options and arguments.

Table 3: vascert commands

Command Description

clean Clears certificate enrollment state information.

configure Allows you to configure Certificate Autoenrollment settings.

importca Imports trusted root CA certificates based on policy.

info Dumps the contents of a policy template.

list Lists all configured policy template names.

pulse Performs Certificate Autoenrollment processing.

renew Renews an existing certificate based on a policy template.

server Manages local policy server configuration.

trigger Triggers machine-based Certificate Autoenrollment policy processing.

unconfigure Allows you to un-configure Certificate Autoenrollment settings.

Common options

The following options can be passed to all vascert commands. Specify these options before
the command name.

[-d <debug level [1-6]> ]

Prints additional information according to debug level, higher debug level prints
more output.

[-b]
Do not display banner text.
[-h <command>]

Display help for a particular command.

vascert commands and arguments

The following is a detailed description of all the available vascert commands, their usage
and arguments.

vascert clean

Clears certificate enrollment state information.
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vascert [common options] clean [-u <username>] [-x]

Arguments:

[-u <username>] is the name of the user to perform the operation.

[-x] removes all local state information.

Additional Information:

This command causes Certificate Autoenrollment to remove all previous
configuration and downloaded policy. When run as root with the -x option, this
command removes all local state information returning the system to the state it had
just after package install.

vascert configure

Allows you to configure Certificate Autoenrollment settings.

vascert [common options] configure <sub-command> <command>

Sub-commands:

debug enables debug logging for all Certificate Autoenrollment components.
Debug command arguments:
vascert [common options] configure debug [-u <username>]

[-u <username>] is the name of the user to perform the operation.

vascert importca

Imports trusted root CA certificates based on policy.

vascert [common options] importca [-u <username>] [-p]

Arguments:

[-u <username>] is the name of the user to perform the operation.

[-p] simulates policy-based CA import.

vascert info

Dumps the contents of a policy template.

vascert [common options] info <policy template name>

vascert list

Lists all configured policy template names.

vascert [common options] list [-p]
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Arguments:

[-p] lists pending enroliment requests.

vascert pulse

Performs Certificate Autoenrollment processing.

vascert [common options] pulse [-p]

Arguments:

[-p] simulates policy-based pulse.

vascert renew

Renews an existing certificate based on a policy template.

vascert [common options] renew -t <template name>

Arguments:

-t <template name> is the name of the policy template for which certificates are
to be renewed.

vascert server

Manages local policy server configuration.

vascert [common options] server <sub-command>

Sub-commands:

remove removes a policy server configuration by URL.
list lists policy servers that are configured locally.
add adds a new local server configuration.
Remove command arguments:
vascert [common options] server remove [-u <username>] [-a] <URL>
[-u <username>] is the name of the user to perform the operation.
[-a] removes all server configurations.
List command arguments:
vascert [common options] server list [-u <username>]
[-u <username>] is the name of the user to perform the operation.
Add command arguments:

vascert [common options] server add [-u <username>] [-c <cost> ] -r <URL> [-
n <name> |
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[-u <username>] is the name of the user to perform the operation.

[-c <cost>] specifies the cost associated with this server. Servers with lower cost are
preferred when performing server selection.

-r <URL> specifies the service endpoint to contact to object enroliment policy.

[-n <name>] specifies the display name of this server.

vascert trigger

Triggers machine-based Certificate Autoenrollment policy processing.

vascert [common options] trigger

vascert unconfigure

Allows you to un-configure Certificate Autoenrollment settings.

vascert [common options] unconfigure <sub-command> <command>

Sub-commands:

debug disables debug logging for all Certificate Autoenrollment components.
Debug command arguments
vascert [common options] unconfigure debug [-u <username>]

[-u <username>] is the name of the user to perform the operation.

@NE IDENTITY Safeguard Authentication Services 6.1 macOS Administration Guide 22

by Quest Certificate Autoenrollment



About us

One Identity solutions eliminate the complexities and time-consuming processes often
required to govern identities, manage privileged accounts and control access. Our solutions
enhance business agility while addressing your IAM challenges with on-premises, cloud and
hybrid environments.

Contacting us

For sales and other inquiries, such as licensing, support, and renewals, visit
https://www.oneidentity.com/company/contact-us.aspx.

Technical support resources

Technical support is available to One Identity customers with a valid maintenance contract
and customers who have trial versions. You can access the Support Portal at
https://support.oneidentity.com/.

The Support Portal provides self-help tools you can use to solve problems quickly and
independently, 24 hours a day, 365 days a year. The Support Portal enables you to:

e Submit and manage a Service Request

» View Knowledge Base articles

e Sign up for product notifications

» Download software and technical documentation

e View how-to videos at www.YouTube.com/Oneldentity
e Engage in community discussions

e Chat with support engineers online

e View services to assist you with your product
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